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INTRODUCTION

The GA-1310 media pack includes a set of software utilities that allow you to 
manage the GA-1310, as well as the print workflow and content of the jobs on
the GA-1310.

This document provides an overview of how to install, configure, and use the 
following GA-1310 utilities:

• Command WorkStation, Windows Edition

• Impose

• Command WorkStation, Macintosh Edition

• Remote Scan

• Fiery Bridge

• Hot Folders

• WebTools
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Terminology and conventions
This document uses the following terminology and conventions.  

Term or convention Refers to

Aero GA-1310 (in illustrations and examples)

Copier                                      The copier attached to the GA-1310

GA-1310                                  GA-1310

Mac OS Apple Mac OS X

Titles in italics Other documents in this set

Windows Microsoft Windows 2000, Windows XP, Windows Server 2003, 
Windows Vista

Topics for which additional information is available by starting Help 
in the software

Tips and information

Important information

Important information about issues that can result in physical harm to 
you or others
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About this document
This document covers the following topics:

• Command WorkStation, Windows Edition: Monitoring and managing the print workflow 
of jobs on the GA-1310.

• Impose: Applying imposition layouts to jobs for custom printing, binding, and cutting 
purposes (Windows only).

• Command WorkStation, Macintosh Edition: Monitoring and managing the print workflow 
of jobs on the GA-1310.

• Remote Scan: Initiating and retrieving a scan on the copier from a remote computer on the 
network. Includes the Scan TWAIN plug-in module. 

• Fiery Bridge: Accessing scanned documents in your GA-1310 mailbox directly from a 
client Windows XP/Vista computer.

• Hot Folders: Storing and reusing frequently used print options when printing PostScript 
and PDF files on the GA-1310. Available as an option.

• WebTools: Managing your GA-1310 remotely from the Internet or your company’s 
intranet.

For information about installing, configuring, and using ColorWise Pro Tools, see 
Color Printing. 

About Help

Detailed instructions on using most GA-1310 utilities are provided in Help. Wherever 
appropriate, this document refers you to Help for additional information and explains how to 
access Help for each utility. 
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Preparing for installation on Windows computers
Before installing GA-1310 software on a Windows computer, complete the following:

• To use GA-1310 user software on a Windows computer, the Sun Java file, Java Runtime 
Environment (JRE), provided in the Common Utilities folder on the User Software DVD, 
must be installed on your computer. If the correct Sun Java file is not installed, the Fiery 
User Software Installer installs it automatically before installing the GA-1310 software. 

NOTE: The recommended version of JRE is provided on the User Software DVD.

• To install the GA-1310 software, you must have Service Pack 4 installed on a Windows 
2000 computer, and Service Pack 2 installed on a Windows XP computer. If you do not, a 
warning message alerts you to install the Service Pack.

Different versions of Sun Java JRE can be installed on your computer. The GA-1310 software 
automatically finds the correct version, so you do not need to uninstall other versions of Sun 
Java JRE required for third-party applications.
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Installing user software
You can install GA-1310 user software in the following ways:

• From the User Software DVD

• From the GA-1310, using the Internet or intranet

If you previously installed any GA-1310 user software on your computer, the installer allows 
you to uninstall those applications.

Installing user software on a Windows computer

All installation of user software on a Windows computer is done through the Fiery User 
Software Installer. The following procedures describe installing from the DVD or over the 
Internet, and also modifying the user software.

The only applications that are not installed by the Fiery User Software Installer are Adobe 
Acrobat and Enfocus PitStop, for use with Impose. For more information, see “Installing 
Adobe Acrobat and Enfocus PitStop” on page 31.

TO INSTALL USER SOFTWARE ON A WINDOWS COMPUTER FROM THE USER SOFTWARE DVD

1 Insert the User Software DVD into the DVD drive of your computer.

The installer Welcome screen appears.

2 Follow the on-screen instructions.

Do not attempt to install user software by opening the individual folders for the applications. 
Always use the Fiery User Software Installer.

To modify or remove any user software after you install it on your computer, use the User 
Software DVD and the following procedure.
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TO MODIFY USER SOFTWARE USING THE USER SOFTWARE DVD INSTALLER

1 Insert the User Software DVD into the DVD drive of your computer.

2 On the window that appears, select Modify, Repair, or Remove.

3 Follow the on-screen instructions.

If your computer does not have a DVD drive, you can install the GA-1310 user software over 
the Internet from WebTools. Ask your network administrator for the IP address of the 
GA-1310.

Use your Internet browser to access WebTools. For complete information about browser and 
system requirements, see Welcome.

TO INSTALL USER SOFTWARE ON A WINDOWS COMPUTER OVER THE INTERNET 

1 Start your Internet browser. 

2 Type the IP address or DNS name of the GA-1310.

The GA-1310 home page appears. 

3 Click the Downloads tab.

4 Click the link for the software that you want to install.

5 Choose Run to open the file or Save to save it to your computer.

If you choose Run, proceed to step 8.

If you choose Save, proceed to step 6.

6 Browse to the location where you want to save the USERSWMI.exe file, and then click Save.

The file is downloaded from the GA-1310.

7 Double-click the USERSWMI.exe file.

8 Type the GA-1310 URL, http://<IP address>, when prompted. 

9 Follow the on-screen instructions.

For complete instructions on how to use Downloads, see Downloads Help. 

For more information about WebTools and Downloads, see “Using WebTools” on page 65.

Do not attempt to install user software by opening the individual folders for the applications. 
Always use the Fiery User Software Installer.
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Installing user software on a Mac OS computer 

Installation of user software on a Mac OS computer is done separately for each application. 

TO INSTALL USER SOFTWARE ON A MAC OS COMPUTER FROM THE USER SOFTWARE DVD

1 Insert the User Software DVD into the DVD drive of your computer.

2 Browse to the OSX folder.

3 Double-click the installer icon for the application that you want to install.

4 Follow the on-screen instructions.

You can also install the GA-1310 user software from the Internet. Consult your network 
administrator for the IP address of the GA-1310.

Use your Internet browser to access WebTools. For complete information about browser and 
system requirements, see Welcome.

TO INSTALL USER SOFTWARE ON A MAC OS COMPUTER OVER THE INTERNET 

1 Start your Internet browser. 

2 Type the IP address or DNS name of the GA-1310.

The GA-1310 home page appears. 

3 Click the Downloads tab.

4 Click the link for Mac OSX Client Software Installer.

The osxutils.dmg file is downloaded to your computer and a virtual disk appears on your 
desktop.

5 Follow the on-screen instructions.

For complete instructions on using Downloads, see WebTools Downloads Help. 

For more information about WebTools and Downloads, see “Using WebTools” on page 65.
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COMMAND WORKSTATION, WINDOWS EDITION

Command WorkStation, Windows Edition allows GA-1310 operators (or users with 
Operator or Administrator privileges) to monitor and manage the print workflow of jobs on 
the GA-1310. Command WorkStation, Windows Edition allows you to do the following:

• View the print status of jobs on the GA-1310

• Hold, process, and print jobs

• Override user-assigned print option settings

• Preview the page content of a job

• Reorder pages in a job and combine pages from different jobs

• Create and use FreeForm master files for variable data printing

• Archive job files

• View job logs of recent print activity

• Define virtual printers

• Manage Fonts

• Access Impose 
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Installing Command WorkStation, Windows Edition
Install Command WorkStation, Windows Edition on a Microsoft Windows computer 
that has a network connection to the GA-1310. For a complete list of system requirements, 
see Welcome.

The installer for Command WorkStation, Windows Edition is provided on the User Software 
DVD. In addition to the Command WorkStation software, the installer installs the Java files 
required to use Fiery Setup from Command WorkStation. For information about using Fiery 
Setup, see Configuration and Setup.

NOTE: ColorWise Pro Tools is installed automatically when you install Command 
WorkStation. For information about using ColorWise Pro Tools, see Color Printing.

Before you install the utility, read the guidelines described in “Preparing for installation on 
Windows computers” on page 10.

To install Command WorkStation, see “Installing user software on a Windows computer” on 
page 11.
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Configuring the connection to the GA-1310
The first time you start Command WorkStation, you are prompted to configure the 
connection to the GA-1310.

You can also edit the configuration whenever there is any change to your GA-1310 or 
network, such as a changed server name or IP address. If you change GA-1310 Setup 
information, do so before you reconfigure the connection. For information about 
reconfiguring the connection, see “To modify the configuration for Command 
WorkStation, Windows Edition” on page 18.

BEFORE YOU BEGIN

• Print the GA-1310 Configuration page. 

For instructions on printing the Configuration page, see Configuration and Setup.

This page contains information you need when configuring the connection, such as the 
IP address of the GA-1310. For TCP/IP installations, you can use the DNS name instead of 
the IP address. Make sure that the GA-1310 is registered in a Domain Name Server (DNS) 
on your network. For more information, contact your network administrator. 

TO CONFIGURE THE CONNECTION FOR COMMAND WORKSTATION, WINDOWS EDITION

1 Choose Start  >  Programs  > Fiery   >  Command WorkStation to start the utility.

The Available Servers dialog box appears and displays all servers found in the local subnet. 
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2 If no GA-1310s are found, click the Manual tab to search by DNS name or IP address. Type the 
DNS name or IP address and click Add to add the server to the Available Servers list.

If no GA-1310s are found by Manual search, click the Auto Search tab, and then click 
Advanced to search by a range of IP addresses or by the IP address and subnet mask. 

All available servers appear in the Available Servers list.

3 Select the GA-1310 that you want to use and click Add.

The selected GA-1310 is added to the Login Server window.
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4 Click the button to the left of the server name.

The Login dialog box appears.

5 Click the key to the left of Administrator, Operator, or Guest and type the appropriate 
password, if required.

6 Click Log In.

For information about setting passwords and the default Administrator password for the 
GA-1310, see Configuration and Setup.

Command WorkStation is now connected to the GA-1310.

TO MODIFY THE CONFIGURATION FOR COMMAND WORKSTATION, WINDOWS EDITION

1 Start Command WorkStation.

The Login Server window appears.

2 Select the GA-1310 for which you want to modify the configuration and click Remove.

3 Repeat “To configure the connection for Command WorkStation, Windows Edition” on 
page 16.
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Using Command WorkStation, Windows Edition
After you install and configure Command WorkStation, you can begin using it to monitor 
and manage jobs on the GA-1310. 

For complete instructions on using the standard Command WorkStation features, see 
Command WorkStation Help. Additional features are described in the sections starting on 
page 20. 

TO ACCESS COMMAND WORKSTATION HELP

1 Start Command WorkStation.

Select the GA-1310 from the Server List dialog box and log on to the server.

For information about setting passwords and the default Administrator password for the 
GA-1310, see Configuration and Setup. 

2 Choose Help from the Help menu.
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Additional features
The following sections describe how to use additional features of Command WorkStation that 
are not discussed in Command WorkStation Help.

User Authentication

If user authentication is enabled in GA-1310 Setup, users may need to type a user name and 
password in the printer driver to send a job to the GA-1310. Management of the job in 
Command WorkStation is determined by how you log on to the GA-1310 (as Administrator, 
Operator, or Guest).

For information about setting up Users and Groups and enabling user authentication in the 
Configure WebTool, see Configuration and Setup. For information about User Authentication 
in the printer driver, see Print Options.

For information about entering User Authentication login information, see Driver Help.

Align Trays

The Align Trays feature allows you to adjust the placement of text and images on the page 
so that they are correctly aligned on a sheet of paper. This ensures that both sides of a duplex 
sheet have exactly the same alignment.

You can also perform tray alignment from the GA-1310 copier touch panel by choosing Tray 
Alignment from the Functions menu.

To perform tray alignment, you must do the following:

• Log on to the GA-1310 with Administrator privileges and enable tray alignment in 
GA-1310 Setup.

• Enable Tray Alignment in the Media area of the printer driver.

• Select the correct paper tray before printing.

NOTE: For Tray Alignment to work when printing a job, select the tray that you have aligned 
in the Media area before printing. If you later print a job using the auto tray selection, the 
alignment does not work. 
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TO ALIGN PAGES FOR PRINTING

1 In the Active Jobs window, select the connected GA-1310 for which you want to perform tray 
alignment.

If the Active Jobs window is hidden, choose Active Jobs from the Window menu to display it.

2 Choose Align Trays from the Server menu.

A dialog box containing the Tray Alignment options appears.

3 Choose the tray that you want to align from the Tray menu.

4 Choose the paper size loaded in the tray from the Media menu.

NOTE: The alignment is specific to the combination of tray and paper size specified. If you 
align a given tray with Letter paper, and then load Legal paper in that tray, the alignment is 
wrong. You must perform a new alignment for each combination of tray and paper size.

5 In the Print Alignment Page area, select the Print Duplex option to print a duplex page, or 
clear the option to print a simplex page.

6 Click Print.

7 After the Alignment Page is printed, follow the instructions on the page. 

Fold the page exactly in half horizontally, unfold it, and then fold it in half vertically. When 
you unfold the sheet, observe that the fold lines cross three scales on three sides of the page. 
Determine which number on the scale each fold line crosses.
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8 In the Enter alignment values area, enter the value that appears where the fold crosses each 
of the three scales, marked A, B, and C, for Side 1. If you choose to align for duplex printing, 
enter the values for the three scales on Side 2 of the page, as well.

NOTE: If you enter different values in A and C, the image rotates, leading to uneven areas on 
printed output. If this occurs, enter the same value in A and C.

9 After you enter the alignment values, click Apply, and then click Check Alignment to print 
the new alignment page. 

10 To remove the alignments, select a tray and click Defaults in the Enter alignment values area.

11 Click Done.

Mixed Media

The Mixed Media feature allows you to define the chapter divisions of a job, print ranges of 
pages on varying types of media, insert blank media between pages, and insert tab media 
containing text labels.

The following guidelines and restrictions apply to Mixed Media settings:

• The Mixed Media dialog box restricts you from specifying settings that conflict with 
any media, page size, or finishing settings that have been specified for the job in the 
Job Properties dialog box or printer driver. 

• When two or more Mixed Media settings are in conflict with each other, the Mixed Media 
dialog box highlights the setting names in red, signaling you to resolve the conflict.

• When you specify print options (in the Job Properties dialog box or printer driver) after 
specifying Mixed Media settings, certain print options may conflict with the page-specific 
Mixed Media settings. You must resolve the conflict by choosing different print options or 
removing certain Mixed Media specifications.

• If counters are configured for the copier, blank media inserted between pages count as 
printed pages.

Basic instructions for accessing and using Mixed Media are provided in Command 
WorkStation Help. Features specific to the GA-1310 are described in the following 
procedures.
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TO DEFINE MIXED MEDIA SPECIFICATIONS

1 Select a spooled/held job in the Active Jobs window and choose Properties from the Actions 
menu, or right-click a spooled/held job in the Active Jobs window and choose Properties, or 
double-click a job.

2 Click the Media icon and scroll down to Mixed Media.

The Mixed Media dialog box lists any previously defined media settings and includes buttons 
for defining, modifying, and removing settings.

3 For Chapter Start Page(s), type the page numbers on which you want to start new chapter 
sections.

Type page numbers as comma-separated values (for example: 4,9,17) to designate the start 
of each new chapter. This feature forces each starting page to use a right-side page, adding 
a preceding left-sided blank, if required. 

NOTE: It is not necessary to type the first page, and page numbers refer to the numbering of 
the original document. If you use the Chapter Start Page(s) feature, all media specified in the 
Paper menu per chapter must share the same dimensions (for example, all Letter, all Tabloid, 
or all A4).

4 To apply finishing options (for example, stapling or sorting) to each chapter created using 
the Chapter Start feature, select the “Define Each Chapter As A Separate Finishing Set” 
option.

NOTE: Not all finishing options can be applied to chapters that contain mixed sizes of media 
(for example, Letter and A4).

5 To define properties for front and back covers, click Define Cover. 

For more information, see “To define cover media settings” on page 24.
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6 To define properties for individual pages or page ranges, click New Page Range.

For more information, see “To define media for specific pages” on page 25.

7 To insert blank pages, click New Insert.

For more information, see “To insert blank pages” on page 26.

8 To insert tab media, click New Tab.

The Insert Tab dialog box appears. For information about defining tab settings, see page 26.

NOTE: The Insert Tab feature is not available for imposed jobs.

9 To modify or delete a current definition, select it in the Mixed Media Definition list, and click 
Edit or Delete.

If you click Edit, enter new settings for the definition and click Modify.

10 After you finish defining Mixed Media settings, click OK to close the Mixed Media dialog box 
and Job Properties.

The Mixed Media settings are applied to the job.

NOTE: You can save up to 100 different settings for the Selection list in the Mixed Media 
dialog box.

TO DEFINE COVER MEDIA SETTINGS

1 In the Mixed Media dialog box, click Define Cover.

The Cover Media dialog box appears.
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2 To define identical front cover and back cover media, select the “Apply the same settings 
for both front and back cover” option. To define media settings for the front or back cover 
individually, select the Front Cover or Back Cover option.

3 Choose other settings, as required, from the pull-down menus.

4 Click OK to return to the Mixed Media dialog box.

Cover Media settings override settings defined in the Page/Page Range Media dialog box.

TO DEFINE MEDIA FOR SPECIFIC PAGES

1 In the Mixed Media dialog box, click New Page Range.

The Page/Page Range Media dialog box appears.

2 Type pages and page ranges as comma-separated values (for example: 3,9–14,18).

3 Choose other settings, as required, from the pull-down menus.

If you assign a new media type to the back side of a duplexed sheet, a blank page is inserted to 
force the assigned page content to the front side of the next sheet.

4 Click Add Definition after each media setting that you define. 

5 Click Close to return to the Mixed Media dialog box.
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TO INSERT BLANK PAGES

1 Click New Insert in the Mixed Media dialog box.

The Insert Blank dialog box appears.

2 Indicate whether to insert the blank before or after the target page. Define the target 
page as the first or last page in the document, or as a specific numbered page.

3 Choose other settings, as required, from the pull-down menus.

4 Click Insert after each blank page that you define.

5 Click Close to return to the Mixed Media dialog box.

Insert Tabs

The Insert Tabs feature allows you to automatically insert tab pages throughout a job. This 
feature accommodates various sizes and types of tab media stock. You can insert the tab text 
and override text attributes on a per-job basis.

NOTE: When you configure counters for the copier, printed tab pages count as black-and-
white pages, provided colors are calibrated to use pure black toner. Expelled tabs are not 
counted as printed pages.
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TO INSERT TAB PAGES

1 Select or right-click a spooled/held job in the Active Jobs window and choose Properties from 
the Actions menu, or double-click a job.

2 Click the Media icon and scroll down to Mixed Media.

3 Click New Tab in the Mixed Media dialog box.

The Insert Tab dialog box appears. 

4 Type the number of tab positions included in a complete tab set in the “Number of tabs 
in a set” field.

This specification ensures that tab text is printed in the correct tab positions. For example, 
tab positions in a set consisting of ten tabs are distinct from tab positions in a set consisting of 
five tabs. 

5 Specify other settings, as required, for the tab stock.

Paper Size values refer to the dimensions of the stock, including the tabbed portion.
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6 To specify attributes for the tab text, type the number of tabs in the “Number of tabs to 
insert” field, and then click Insert.

Use the following procedure to define the tab text.

TO SPECIFY TAB TEXT

1 In the Tabs Text dialog box, select the “Apply the same text attributes for all tabs” option if 
you want all the tabs to use the same text attributes. 

2 Click Insert.

3 Click Text Attributes.

Specify the rotation, alignment, font, and size attributes of the tab text, and then click OK.

4 Indicate where you want each tab inserted in the document.

• In the Page field, type the page number where you want the tab inserted.

• Select Before to insert the tab before the page number, or clear this check box.

NOTE: If you define a tab to be inserted between an odd-numbered page and an even-
numbered page in a duplex job, the tab is inserted after the odd-numbered page on the first 
sheet, and the even-numbered page is printed on the next sheet.

5 Type the desired tab text for each tab in the Tab Text field.

To define text attributes for each tab individually, click Text Attributes for that tab.

6 After you type the tab text, click OK to close the Tabs Text dialog box.

The Mixed Media dialog box displays the current tab settings in the Mixed Media 
Definition list.

7 To modify media settings for the tabs, select the tab description in the Mixed Media 
Definition list, and then click Edit.

8 To apply your Insert Tab settings to the document, click OK to close the Mixed Media dialog 
box and Job Properties.
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Troubleshooting
When troubleshooting basic connection and software problems with Command 
WorkStation, see the following sections. For additional troubleshooting information,  
see Command WorkStation Help.

Command WorkStation cannot connect to the GA-1310

If you cannot connect to the GA-1310 or locate the GA-1310 from your computer, contact 
the network administrator. The administrator may need to troubleshoot your network 
connections and check settings on the servers that you print to. If settings have changed, it 
may be necessary to reconfigure the GA-1310 (see Configuration and Setup).

If you can connect to the GA-1310 with another utility, you may need to reconfigure the 
Command WorkStation connection to the GA-1310 (see page 16).

If you configured the GA-1310 and set up client computers and network servers according to 
the instructions in Configuration and Setup, print a Test Page. If you can print the Test Page 
but still cannot print a document from a remote computer, contact your network 
administrator to troubleshoot the network connection.

If you cannot connect and cannot print a Test Page, check the copier touch panel for error 
information.

Command WorkStation does not respond

If Command WorkStation is unresponsive, use the following troubleshooting guidelines.

IF THE COMMAND WORKSTATION WINDOWS DO NOT UPDATE

1 Log off and then quit Command WorkStation. 

2 Restart Command WorkStation or restart the computer. 

If the Command WorkStation windows do not update or no jobs are displayed, and the 
mouse has no effect (you cannot select a job or a window, use a right mouse command, or 
select a menu item), the GA-1310 is offline or network communication has failed.

TO FORCE AN EXIT FROM COMMAND WORKSTATION

1 Press Ctrl-Alt-Delete and use the Task Manager to close Command WorkStation. 

2 At the GA-1310, disconnect and reconnect the network cable, and then try printing a Test 
Page or Configuration page.

3 If printing fails, restart the GA-1310.
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IMPOSE

Impose is a utility (available as an option) that you access from Command WorkStation, 
Windows Edition. Impose allows you to do the following:

• Apply imposition layouts to jobs for custom printing, binding, and cutting

• Apply impositions to variable data jobs

• Save the imposed jobs as PDF files

Installing and enabling Impose
The following sections describe how to install and enable Impose.

Installing Impose

The Impose software is automatically installed when you install Command WorkStation, 
Windows Edition from the User Software DVD. 

Do not attempt to install Impose manually from the User Software DVD (by starting the 
setup.exe from the Impose folder). It is automatically installed when you install Command 
WorkStation. Installing Impose separately from Command WorkStation can cause 
unpredictable results. 

To enable Impose on a client computer, you must:

• Install Adobe Acrobat and Enfocus PitStop Professional.

NOTE: The Adobe Acrobat/Enfocus PitStop DVD is provided in the Impose Media Pack.

• Install the Impose software protection key (dongle) into the correct port of the 
client computer.

If you see a dongle installed on the computer, Impose has already been enabled and is ready 
for use. If the dongle is not installed, see the documentation that is provided in the Impose 
kit. Without a dongle installed, you can use Impose in Demo mode. Demo mode allows you 
to impose documents and save them, but all printed output displays a “Demo” watermark.

NOTE: The protection key (dongle) may be either a parallel port type or a USB type dongle. 
For more information, see the documentation that is provided in the Impose kit.
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Installing Adobe Acrobat and Enfocus PitStop

To use Impose, you must install the Acrobat and the PitStop Professional plug-in for Acrobat 
for use with Impose from the installer DVD provided in your Impose kit. Impose is installed 
when you install Command WorkStation, and is accessed from Command WorkStation. 

NOTE: If you install Acrobat after Command WorkStation, you may need to restart 
Command WorkStation in order to use Impose. 

Instructions are provided in your Impose kit for installing Acrobat and PitStop Professional. 
We recommend that you follow those instructions.

We recommend that you install the version of Acrobat provided in your Impose kit and 
remove any other versions of Acrobat installed on your computer.

TO INSTALL THE PDF SUPPORT APPLICATIONS

1 Uninstall all versions of Acrobat that are currently installed on the computer.

• Close all open applications.

• Follow the Windows instructions for removing programs.

Make sure to delete not only the main folder for the application but also the associated 
Acrobat folder located, by default, in C:\Program Files\Common Files\Adobe. (The exact 
drive letter may vary, depending on the computer.)

2 Restart the computer after you finish uninstalling earlier versions of Acrobat.

3 Close all software applications that are currently running on the computer.

4 Insert the Adobe Acrobat/Enfocus PitStop DVD into the DVD drive.

5 If the installer does not start automatically, browse to the location of the DVD drive and 
double-click the PDF_Applications icon.

6 At the message reminding you to close all applications, click Yes.

7 At the next installation screen, make sure “Adobe Acrobat” and “PitStop” are both selected, 
and then click Next.

Wait while the installer copies software files to the computer and displays progress bars.

8 At the message indicating a successful installation, click Finish.

You can now start Acrobat and configure the recommended program settings, as described in 
the following procedure.
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TO CONFIGURE ACROBAT SETTINGS

NOTE: We recommend that you configure the following settings when starting Acrobat for the 
first time. These are the recommended Acrobat settings for use with Impose.

1 Double-click the Acrobat program icon to start the application.

By default, the Acrobat program icon is located in C:\Program Files\Adobe\Acrobat 8.0. 
(The exact drive letter may vary, depending on the computer.)

2 At the License Agreement window, choose a language for displaying the agreement, and then 
click Accept.

3 At the Activate Adobe Acrobat 8 Standard window, do one of the following:

• To activate Acrobat over the Internet, click the Activate button. Wait for the activation 
process to finish.

• To activate Acrobat over the telephone, click “Other activation options.” Select “Over the 
Telephone,” and click OK to display the Phone Activation window. 

Call the telephone number listed for your location, and follow the voice instructions. 
When prompted, use the telephone keypad to enter the serial number and activation 
number listed in the Phone Activation window. Listen carefully for the authorization code, 
and enter it into the Authorization Code fields on the Phone Activation window. Click the 
Activate button to complete the activation process.

You must complete the activation process upon first starting Acrobat in order to use Acrobat 
with Impose. Do not choose the Activate Later option if it appears on the screen.

4 When the activation process is finished, click Done.

5 At the Getting Started window, select “Do not show at startup.” Then close the Getting 
Started window.

You can access the window later by choosing Getting Started from the Help menu.

6 Close the Acrobat application to save your configuration settings.

If the latest version of Command WorkStation is already installed on the computer, Impose is 
now fully enabled. If Command WorkStation is not yet installed, install Command 
WorkStation as described on page 15.
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Using Impose
Complete instructions on how to use Impose are provided in Command WorkStation, 
Windows Edition Help.

TO ACCESS IMPOSE HELP

1 Start Command WorkStation, Windows Edition.

2 Choose Help from the Help menu.

3 Use the Contents, Index, or Search panes to navigate to the Impose Help topics.
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COMMAND WORKSTATION, MACINTOSH EDITION

Command WorkStation, Macintosh Edition allows operators of the GA-1310, or users 
with Operator or Administrator privileges, to monitor and manage the print workflow of 
jobs on the GA-1310. 

Command WorkStation, Macintosh Edition, enables you to do the following:

• View the print status of jobs on the GA-1310.

• Hold, process, and print jobs.

• Override user-assigned print option settings.

• Preview the page content of a job.

• Create and use FreeForm master files for variable data printing.

• Archive job files.

• View Job Logs of recent print activity.

Installing Command WorkStation, Macintosh Edition
Install Command WorkStation, Macintosh Edition on a Mac OS X computer that has 
a network connection to the GA-1310. For complete system requirements, see Welcome.

To install Command WorkStation, Macintosh Edition, see “Installing user software on a Mac 
OS computer” on page 13.

Configuring the connection to the GA-1310
The first time you start Command WorkStation, you are prompted to configure the 
connection to the GA-1310.

You can also edit the configuration whenever there is any change to your GA-1310 server or 
network, such as a changed server name or IP address. If you change GA-1310 Setup 
information, do so before you reconfigure the connection.
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BEFORE YOU BEGIN

• Print the GA-1310 Configuration page. 

For instructions on printing the Configuration page, see Configuration and Setup.

This page contains information that you need when configuring the connection, such as the 
IP address of the GA-1310. For TCP/IP installations, you can use the DNS name instead of 
the IP address. Make sure that the GA-1310 is registered in a Domain Name Server (DNS) 
on your network. For more information, see the documentation that accompanies your 
network system. 

TO CONFIGURE THE CONNECTION FOR COMMAND WORKSTATION, MACINTOSH EDITION

1 Open the Applications  :  Fiery  :  CWS Macintosh Edition folder on the Mac OS X hard disk. 
Double-click the CWS Macintosh Edition file to start the application.

The Available Servers dialog box appears, displaying all servers found in the local subnet.

2 If no GA-1310s were found, click the Manual tab to search by DNS name or IP address. Click 
Add to add the server to the Available Servers list.
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If no GA-1310s were found in the Manual search, click the Auto Search tab, and then click 
Advanced to search by a range of IP addresses or the IP address and subnet mask. 

All available servers are displayed in the Available Servers list.

3 Select the GA-1310 that you want to use and click Add.

The selected GA-1310 is displayed in the Server List dialog box.

4 Click the server name to select it, and then click the key icon or Login button.

The Login dialog box appears.

5 Click administrator, operator, or guest, type the password in the field next to the key, and 
then click Login.

Your computer is connected to the server.

For more information about setting passwords and the default Administrator password for the 
GA-1310, see Configuration and Setup.

To modify the Command WorkStation connection to the GA-1310, you must remove the 
server from the Login Server list and follow the procedure for configuring the connection.
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Using Command WorkStation, Macintosh Edition
After you install and configure Command WorkStation, you can begin using it to monitor 
and manage jobs on the GA-1310. 

Complete instructions on how to use the Command WorkStation features are provided in 
Command WorkStation Help. 

TO ACCESS COMMAND WORKSTATION HELP

1 Start Command WorkStation.

Select the GA-1310 in the server list and log on to the server.

For more information about setting passwords and the default Administrator password 
for the GA-1310, see Configuration and Setup.

2 Choose Help from the CWS menu.
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Additional features
The following sections describe how to use additional features of Command WorkStation that 
are not discussed in Command WorkStation Help.

User Authentication

If user authentication is enabled in GA-1310 Setup, users may need to enter a user name and 
password in the printer driver to send a job to the GA-1310. Management of the job in 
Command WorkStation is determined by how you log on to the GA-1310, as Administrator, 
Operator, or Guest.

For information about setting up Users and Groups and enabling user authentication in 
the Configure WebTool, see Configuration and Setup. For information about User 
Authentication in the printer driver, see Print Options. 

For information about entering User Authentication login information, see Driver Help.

Mixed Media

The Mixed Media feature allows you to define the chapter divisions of a job, print ranges of 
pages on varying types of media, insert blank media between pages, and insert tab media 
containing text labels.

The following guidelines and restrictions apply to Mixed Media settings:

• The Mixed Media dialog box restricts you from specifying settings that conflict with any 
media, page size, or finishing settings that have been specified for the job in the Job 
Properties dialog box or printer driver.

• When two or more Mixed Media settings are in conflict with each other, the Mixed Media 
dialog box highlights the setting names in red, signaling you to resolve the conflict.

• When you specify print options (in the Job Properties dialog box or printer driver) after 
specifying Mixed Media settings, certain print options may conflict with the page-specific 
Mixed Media settings. You must resolve the conflict by choosing different print options or 
removing certain Mixed Media specifications.

• If counters are configured for the copier/printer, blank media inserted between pages 
count as printed pages.

Features specific to the GA-1310 are described in the following procedures.

NOTE: The procedures for defining Mixed Media settings in Command WorkStation, 
Windows Edition are similar to those in Command WorkStation, Macintosh Edition, 
but include illustrations. For information, see page 22.
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TO DEFINE MIXED MEDIA SPECIFICATIONS

1 Select or right-click a spooled/held job in the Active Jobs window and choose Properties from 
the Actions menu, or double-click a job.

2 Click the Media icon and scroll down to Mixed Media.

The Mixed Media dialog box lists any previously defined media settings and includes buttons 
for defining, modifying, and removing settings.

3 For Chapter Start Page(s), type the page numbers on which you want to start new chapter 
sections.

Type page numbers as comma-separated values (for example: 4,9,17) to designate the start 
of each new chapter. This feature forces each starting page to the right side, adding a 
preceding left-sided blank, if required. 

NOTE: It is not necessary to type the first page. Page numbers refer to the numbering of the 
original document. If you use the Chapter Start Page(s) feature, all media specified in the 
Paper menu per chapter must share the same dimensions (for example, all Letter, all Tabloid, 
or all A4).

4 To apply finishing options (for example, stapling or sorting) to each chapter created using 
the Chapter Start feature, select the “Define Each Chapter As A Separate Finishing Set” 
option.

NOTE: Not all finishing options can be applied to chapters that contain mixed sizes of media 
(for example, Letter and A4).

5 To define properties for front and back covers, click Define Cover. 

For more information, see “To define cover media settings” on page 40.

6 To define properties for individual pages or page ranges, click New Page Range.

For more information, see “To define media for specific pages” on page 40.

7 To insert tab media, click New Tab.

The Insert Tab dialog box appears. For information about defining tab settings, see page 41.

NOTE: The Insert Tab feature is not available for imposed jobs.

8 To insert blank pages, click New Insert.

For more information, see “To insert blank pages” on page 40.

9 To modify or delete a current definition, select it in the Mixed Media Definition list, and then 
click Edit or Delete.

If you click Edit, enter new settings for the definition and click Modify.

10 After you finish defining Mixed Media settings, click OK to close the Mixed Media dialog box 
and Job Properties.

The Mixed Media settings are applied to the job.

NOTE: You can save up to 100 different settings for the Selection list in the Mixed Media 
dialog box.
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TO DEFINE COVER MEDIA SETTINGS

1 In the Mixed Media dialog box, click Define Cover.

The Cover Media dialog box appears.

2 To define identical front cover and back cover media, select the “Apply the same settings 
for both front and back cover” option. To define media settings for the front or back cover 
individually, select the Front Cover or Back Cover option.

3 Specify other settings, as required.

4 For Cover Page Mode, define how you want the content printed on the cover. You can 
specify printing on the front side only, back side only, or both sides of the cover page.

5 Click OK to return to the Mixed Media dialog box.

Cover Media settings take precedence over settings defined in the Page/Page Range Media 
dialog box.

TO DEFINE MEDIA FOR SPECIFIC PAGES

1 Click New Page Range in the Mixed Media dialog box.

The Page/Page Range Media dialog box appears.

2 Type pages and page ranges as comma-separated values (for example: 3,9–14,18).

3 Specify other settings, as required.

If you assign a new media type to the back side of a duplexed sheet, a blank page is inserted to 
force the assigned page content to the front side of the next sheet.

4 Click Add Definition after each media setting that you define. 

5 Click Close to return to the Mixed Media dialog box.

TO INSERT BLANK PAGES

1 Click New Insert in the Mixed Media dialog box.

The Insert Blank dialog box appears.

2 Indicate whether to insert the blank before or after the target page. Define the target 
page as the first page in the document, the last page in the document, or a specific 
numbered page.

3 Specify other settings, as required, for the blank page.

4 Click Insert after each blank page that you define.

5 Click Close to return to the Mixed Media dialog box.
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Insert Tabs

The Insert Tabs feature allows you to automatically insert tab pages throughout a job. 
This feature accommodates various sizes and types of tab media stock. Users can insert the 
tab text and override text attributes on a per-job basis.

NOTE: The Insert Tabs feature is not available for imposed jobs.

NOTE: When you configure counters for the copier, printed tab pages count as black-and-
white pages, provided colors are calibrated to use pure black toner. Expelled tabs are not 
counted as printed pages.

TO INSERT TAB PAGES

1 Select or right-click a spooled/held job in the Active Jobs window and choose Properties from 
the Actions menu or double-click a job.

2 Click the Media icon and scroll down to Mixed Media.

3 Click New Tab in the Mixed Media dialog box.

The Insert Tab dialog box appears. 

4 Enter the number of tab positions included in a complete tab set in the “Number of tabs  
in a set” field.

This specification ensures that tab text is printed in the correct tab positions. For example, 
tab positions in a set consisting of ten tabs are distinct from tab positions in a set consisting of 
five tabs. 

5 Specify settings for the tab stock, as required.

Paper Size values refer to the dimensions of the stock, including the tabbed portion.

NOTE: Neither the GA-1310 nor the copier recognizes the tab positions. You must create 
documents and select items so that the print image is not positioned outside of the tab area.

6 To specify attributes for the tab text, enter the number of tabs in the “Number of tabs  
to insert” field and click Insert. 

7 If you want all tabs to use the same text attributes, select the “Apply the same text 
attributes for all tabs” option. 

8 In the Text Attributes area, click the arrows to display the menus for font, size, text rotation, 
and text alignment, and select the attributes you want from each menu. 
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9 Indicate where you want each tab inserted in the document.

• In the Page field, type the page number where you want the tab inserted.

• Select Before to insert the tab before the page number, or clear the option.

NOTE: If you indicate that a tab is to be inserted between an odd-numbered page and an  
even-numbered page in a duplex job, the tab is inserted after the odd-numbered page on the 
first sheet, and the even-numbered page is printed on the next sheet.

10 Type the tab text for each tab in the Tab Text field.

If required, specify text attributes for each tab individually.

11 After you finish specifying tab text, click OK to close the Insert Tab dialog box.

The Mixed Media dialog box displays the current tab settings in the Mixed Media 
definition list.

12 To modify media settings for the tabs, select the tab description in the Mixed Media 
definition list, and then click Edit.

13 To apply your Insert Tab settings to the document, click OK to close the Mixed Media dialog 
box and Job Properties.
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Troubleshooting
When troubleshooting basic connection and software problems with Command 
WorkStation, see the following sections. For additional troubleshooting information, see 
Command WorkStation Help.

Command WorkStation cannot connect to the GA-1310

If you cannot connect to the GA-1310 or locate the GA-1310 from your computer, contact 
the network administrator. The administrator may need to troubleshoot your network 
connection and check settings on the servers that you print to. If settings have changed, it may 
be necessary to reconfigure the GA-1310.

If you are able to connect to the GA-1310 with another utility, you may need to reconfigure 
the Command WorkStation connection to the GA-1310 (see page 34).

If you configured the GA-1310 and set up client computers and network servers according to 
the instructions in Configuration and Setup, print a Test Page. If you can print a Test Page, but 
still cannot print a document from a remote computer, contact your network administrator to 
troubleshoot the network connection.

Command WorkStation does not respond

If Command WorkStation is unresponsive, use the following troubleshooting guidelines.

IF THE COMMAND WORKSTATION WINDOWS DO NOT UPDATE

1 Log off and then quit Command WorkStation. 

2 Restart Command WorkStation or restart the computer. 

If the Command WorkStation windows do not update, or no jobs are displayed, and the 
mouse has no effect (you cannot select a job or a window, use a Control-click command, or 
select a menu item), the GA-1310 is offline or network communication has failed.

TO FORCE AN EXIT FROM COMMAND WORKSTATION

1 Press Command-Option-Escape and use the Force Quit Applications dialog box to close 
Command WorkStation. 

2 At the GA-1310, disconnect and reconnect the network cable, and then try printing a Test 
Page or Configuration page.

3 If printing fails, restart the GA-1310.
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SCAN

Scan is a collection of software components that allow you to scan documents from the copier 
glass or through the automatic document feeder (ADF) on the copier and send the scanned 
images to various destinations. Scan consists of the following components:

• Remote Scan application allows you to remotely initiate a scan on the copier from your 
desktop and retrieve the scan.

• Remote Scan TWAIN plug-in module allows you to acquire a scan from the copier directly 
into compatible TWAIN compliant applications, such as Adobe Acrobat or Photoshop.

• Scan to FTP allows you to send the scan file to an FTP server.

• Scan to Mailbox allows you to send the scan to a mailbox on the GA-1310, from where it 
can be retrieved.

• Scan to Disk allows you to scan directly to any hard disk on the network, such as your local 
hard disk.

• Scan to Hold queue allows you to scan to the GA-1310 Hold queue for document merging 
and editing.

• Docs WebTool allows you to retrieve scanned jobs from mailboxes on the GA-1310.

In addition to providing instructions for installing, configuring, and using Remote Scan, this 
chapter also describes scanning directly from the copier touch panel.
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Installing and configuring Remote Scan
You can use Remote Scan with the following applications:

• Adobe Acrobat v6.04/7.0.5

• Adobe Photoshop v7.01

• Adobe Photoshop CS2

The following sections describe how to install and configure Remote Scan.

Installing Remote Scan

To install and use the Remote Scan plug-in module, you must have a Windows or Mac OS 
computer with a network connection. For detailed system requirements, see Welcome.

The installer for Remote Scan is located on the User Software DVD.

To install Remote Scan, see “Installing user software on a Windows computer” on page 11 
and “Installing user software on a Mac OS computer” on page 13.



SCAN 46

Configuring Remote Scan

The first time you start Remote Scan, you must configure the connection to the GA-1310. 
Before you configure the connection, you must have the correct IP address. Make sure the 
GA-1310 is registered in a Domain Name Server (DNS) on your network. When you open 
Remote Scan, the Scan Configuration dialog box appears. For instructions on configuring the 
connection to the GA-1310 for the first time, see “To configure the connection to the 
GA-1310” on page 46.

Complete instructions on configuring and modifying the connection to the GA-1310 are also 
provided in Remote Scan Help.

If you have previously configured a connection to the GA-1310, it appears in the main 
Remote Scan window, and you can immediately start to initiate a scan or retrieve any scans 
initiated at the copier touch panel, and use Remote Scan Help. 

TO CONFIGURE THE CONNECTION TO THE GA-1310

1 When you start Remote Scan for first-time use, the Configuration window automatically 
appears. In the Server Name (or IP Address) text field, type the IP address or the DNS name 
of the Print Server.

2 Select Use Nickname to enter another name to distinguish the GA-1310. This name does not 
have to match the actual Server Name of the GA-1310.

3 Type the name of the device connected to the GA-1310. 

You can assign any name of your choice as the device name.

4 Click the green arrow to add the GA-1310 to My Fiery List. 

5 Click OK.

Using Remote Scan
With Remote Scan, you can initiate and retrieve scan files remotely from your desktop. You 
can send the scan file to a number of destinations, such as a mailbox that has been set up on 
the GA-1310, the GA-1310 Hold queue, or any hard disk on the network. All scans are stored 
on the GA-1310 hard disk and retrieved through the network. You can also initiate and 
retrieve a scan file in a host application, such as Photoshop, by using the Remote Scan 
TWAIN plug-in module.

To send a scan to a mailbox, you must first set up the mailbox in WebTools Configure. For 
more information, see “Setting up a Mailbox” on page 49.

For a list of copier-specific settings, see page 52.

NOTE: Remote Scan does not perform when the copier is in power save mode. When you 
want to scan using Remote Scan, confirm that the copier is not in power save mode.



SCAN 47

Using Remote Scan Help

Complete instructions on how to use the standard Remote Scan features are provided in 
Remote Scan Help.

TO ACCESS REMOTE SCAN HELP

1 Start Remote Scan or open the Remote Scan plug-in module.

2 Click the Help button.

3 Use the Contents, Index, or Search panes to navigate to the Remote Scan Help topics.

Scanning with Remote Scan TWAIN plug-in module

The following procedure describes how to use the Remote Scan TWAIN plug-in module 
from a TWAIN compliant application, such as Photoshop.

TO ACQUIRE A SCAN USING THE TWAIN PLUG-IN MODULE

1 Start the TWAIN compliant application.

2 If you are scanning a single original, place it on the copier glass; if you are scanning multiple 
originals, place them in the document feeder.

The copier must be switched online to the network from the copier touch panel display. For 
more information, see the copier documentation.

3 Choose Import from the File menu in the application. 

4 Click Remote Scan.

5 Select the GA-1310 from the list of devices in the Choose Device dialog box.

6 Select the Initiate tab.

7 Select the appropriate scan settings and click Acquire.

The scanned document opens in the TWAIN compliant application.
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Scanning from the copier
You can scan a document from the copier by pressing the Scan button on the front of the 
copier.

When you press the Scan button, you can scan an image from the copier glass or ADF 
Automatic Document Feeder and send the scan to a number of destinations, including a 
mailbox, SMB, FTP, or the GA-1310 Hold queue. 

For instructions for scanning from the copier using the Scan button on the front of the copier, 
see “Scanning from the copier” on page 50.

For more information about scanning by pressing the User Functions button on the front of 
the copier, and then Scan on the copier touch panel, see the documentation that comes with 
your copier.

NOTE: You can also initiate a scan from Remote Scan and send the scan to the GA-1310 Hold 
queue, a mailbox, or a hard disk drive. For more information, see “Using Remote Scan” on 
page 46.

Scan destinations from the copier

When you scan a document from the copier by pressing the Scan button, you have the choice 
of a number of destinations. The destinations are the following:

• Mailbox: Allows you to send the scan file to a Mailbox that you set up in WebTools 
Configure. You must set up the Mailbox first. For more information, see “Setting up a 
Mailbox” on page 49.

• SMB: Allows you to send the scan file to any network folder or computer on the network 
using SMB. You must know the domain, the computer name (server name), and the 
shared folder for the destination computer to send a file using SMB. You are required to 
enter a user name and password. If a password is required, but not entered, no error 
message is displayed, and the scan file is not sent to the destination. It may be that no 
password is required. Check with your network administrator for the login requirements 
for any SMB connection on your network. 

• FTP: Allows you to send the scan file to an FTP site. If a Proxy Server has been enabled by 
the GA-1310 Administrator in Setup, ask the Administrator for the Proxy Address. You 
may be required to enter a user name and password. If the user name is displayed as blank, 
then an anonymous login is allowed, and you do not have to enter a password.

• Hold Queue: Allows you to send the scan file to the GA-1310 Hold Queue. When you 
choose this option, the scan file is displayed in Command WorkStation.

NOTE: Some of these destinations are similar to those available from Remote Scan. The 
information provided in Remote Scan Online Help is applicable to the destinations you can 
choose from the copier.
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Setting up a Mailbox

If you want to send a scanned job that you initiate from Remote Scan, or that you initiate by 
pressing the Scan button on the front of the copier, to a mailbox, you must first set up a 
mailbox in WebTools Configure, by adding a user to the Scan Users group in the Users and 
Groups pane. If you add a password to a mailbox, you will be required to enter the password 
with the mailbox name when you retrieve a scan using Remote Scan or WebTools Docs.

NOTE: In Remote Scan, you must click Change Mailbox to enter the mailbox name and 
password.

In WebTools Configure Help, see the instructions for adding users to a group. Specific 
instructions for adding a scan user/mailbox are provided below.

TO SET UP A MAILBOX

1 In WebTools, select Configure tab, and then Launch Configure.

2 Select Users and Groups. 

3 Select Scan Users in the Group Name column.

4 Click View Detail. 

Details of the Scan Users group are displayed.

5 Click Add.

The default mailboxes/user names are displayed.

6 To create a mailbox, click Add New.

7 Choose a User Name for your mailbox and a password, if required.

When you send a scan file to a mailbox, you must enter the User Name and the password.

8 Click Save and Add.

The new mailbox you have just created is added to the list of Scan Users. 

NOTE: If you build a Scan Users group by retrieving user names and passwords from an LDAP 
server, the Scan Users must enter the domain name and user name when they retrieve scans or 
use the various scan applications. Separate the domain name and user name with a backslash 
(for example, DomainName\UserName).

9 Click Save.

10 Click Close.

11 Click Reboot to save your changes.
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Retrieving scans from a mailbox

When you have created a mailbox, you can send scans to that mailbox from Remote Scan or 
from the copier touch panel. You can then retrieve the scans from WebTools Docs. For 
information on how to do this, see the instructions for downloading jobs from your mailbox 
in WebTools Docs Online Help. You can also retrieve scans from mailboxes by using Fiery 
Bridge on a Windows XP or Vista computer. For more information, see page 55.

Scanning from the copier

You can initiate scanning at the copier by pressing the Scan button on the front of the copier. 

TO MANUALLY SCAN A DOCUMENT 

1 Place the original face down on the copier glass or face up in the Automatic Document 
Feeder.

2 Press the Scan button on the front of the copier.

3 Press SMB/FTP/Other on the copier touch panel.

Other possible destinations are e-Filing, USB, or E-mail. For information about sending scans 
to these destinations, see the documentation that comes with your copier.

4 Select where to send your scan. 

The destinations are: 

• FTP

• SMB

• Hold Queue

• Mailbox

NOTE: To send a scanned document to a Mailbox, you must first set up the Mailbox in 
WebTools Configure, or in Command WorkStation > Server > Setup. For more information, 
see “Setting up a Mailbox” on page 49.

5 To enter information for a specific destination, press the name of each field displayed for 
that destination.

6 Enter the information using the keypad on the copier touch panel, and press OK.
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7 To select Scan Settings, press Common Setting on the copier touch panel and enter the 
appropriate settings.

Options are displayed on three screens. After you have made settings for the first screen of 
options, press the down arrow for the remaining options. For a list of copier-specific settings, 
see “Setting scan options specific to the copier” on page 52.

8 Press Scan or the green Start button and follow on-screen instructions.

9 After the scan is complete, press Job Finish to exit to the Main display of the copier touch 
panel.

Even if you do not press Job Finish, the display eventually reverts to the Main display when 
the copier has finished scanning.
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Setting scan options specific to the copier
If you scan using the Scan button on the copier, you can specify settings for the following 
copier-specific options: 

Option Settings (default is underlined) More information

Color Mode Black, Grayscale, Full Color, Auto Color

Resolution 100, 150, 200, 300, 400, 600 Changing the resolution also changes 
the image file size. 

Original Mode Text, Text/Photo, Photo, Prtd. Image This setting corresponds to Image 
Mode in Remote Scan. Printed Image 
can only be selected if Full Color or 
Auto Color are selected for the Color 
Mode.

Single/2-Sided 
Scan

Single, Book, Tablet

Original Size Auto, A3, A4, A4-R, A5-R, B4, LD, LT, 
LT-R, LG, ST-R, B5, B5-R, 13"LG, 
COMP, FOLIO, 8.5SQ,8K, 16K, 16K-R, 
A6-R

Rotation No rotation, 90 deg., 180 deg.,  
270 deg.

The rotation settings are shown 
graphically on the copier touch panel.

Compress Low, Mid, High

Omit Blank 
Page

On, Off

Outside Erase On, Off

Range 
Adjustment

Manual +(3 to 1), Normal,  
Manual -(1 to 3)

To set range adjustment, On must be 
selected for Outside Erase.

Exposure Manual +(5 to 1), Normal,  
Manual -(1 to 5)

Contrast Manual +(4 to 1), Normal,  
Manual -(1 to 4)

Contrast settings are enabled when 
Printed Image has been selected for 
Original Mode.

Background 
Adjust

Manual +(4 to 1), Normal,  
Manual -(1 to 4)

Specify how much to lighten or darken 
the background.

Sharpness Manual +(4 to 1), Normal,  
Manual -(1 to 4)

File Format PDF, TIFF, JPEG Choose the file format in the 
Destination window when the 
destination is SMB or FTP.
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Setting scan options from Remote Scan
If you scan with Remote Scan, you can specify settings for the following scan options: 

Option Settings (default is underlined) More information

Sides Single-Sided, Top/Top, Top/Bottom This option is only available if you are 
scanning from the ADF (Automatic 
Document Feeder). 

Size Auto Select, A4, A4-R, Letter, Letter-R, 
A5-R, B5, B5-R, 8K, Folio, 13"LG, Legal, 
B4, A3, 11x17(LD), 16K-R, 16K, A6-R, 
8.5"SQ, Statement-R, Computer

If you choose Auto Select, the scan size 
is as follows:

• From the ADF, the image is 
scanned on the page size of the 
original, which is set on the ADF.

• From the platen, the image is 
scanned on Letter size in the US, 
and on A4 elsewhere.

To scan a job of different page sizes, 
choose On for the Mixed option and 
choose Auto Select for the Size option.

Mixed (Original 
Size Mode)

On, Off

Image Mode Text, Image, Text/Image This setting corresponds to Original 
Mode on the copier touch panel.

Exposure Auto, Manual +(5 to 1), Normal, 
Manual -(1 to 5)

Resolution 100, 150, 200, 300, 400, 600 Changing the resolution also changes 
the image file size. The maximum 
supported resolution is displayed in the 
dialog box.

Color Mode Color, Grayscale, Black and White

Compression Minimum Size, Standard, Maximum 
Quality

The Minimum Size setting refers to the 
file size of the scan, not the page size.

Sharpness Manual +(4 to 1), Normal,  
Manual -(1 to 4)

Background 
Adjust

Manual +(4 to 1), Normal,  
Manual -(1 to 4)

Specify how much to lighten or darken 
the background.

Image Rotate No rotation, 90 deg., 180 deg.,  
270 deg.

File Format PDF, TIFF, JPEG Choose the file format after you press 
the Send button when the destination 
is Scan to FTP, or Save to Disk.
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Retrieving scans using Docs

You can retrieve scan jobs in the GA-1310 Mailboxes to your remote workstation using the 
Docs WebTool. For instructions on using Docs, see page 65.

NOTE: You can also access scan jobs in the GA-1310 Mailboxes from a client Windows XP or 
Vista computer using the Fiery Bridge application. For information about Fiery Bridge, see 
page 55.
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FIERY BRIDGE

Fiery Bridge is an application that allows you to access scanned documents in your Fiery 
mailbox directly from a client Windows XP computer.

Fiery Bridge makes your mailbox accessible as if it were a standard network drive, allowing 
you to browse its contents using Windows. You can open a scanned document from an 
appropriate application on your computer, just as you would open any file on your computer.

Fiery Bridge is an alternative to transferring scanned documents from a Fiery using Remote 
Scan or WebTools and can simplify your scanning workflow. You can even use Fiery Bridge in 
combination with Hot Folders to create an automated workflow. 

Installing Fiery Bridge
Install Fiery Bridge on a Windows XP computer that has a network connection to the 
GA-1310. For a complete list of system requirements, see Welcome.

The installer for Fiery Bridge is provided on the User Software DVD. 

Before you install the utility, read the guidelines described in “Preparing for installation on 
Windows computers” on page 10.

To install Fiery Bridge, see “Installing user software on a Windows computer” on page 11.

Configuring Fiery Bridge
To use Fiery Bridge, you must configure the connection to the GA-1310 by completing the 
following tasks:

• Specify one or more GA-1310 that you want to access.

• Configure settings for each server.

Details are provided in the following procedures.
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Specifying servers

When you start Fiery Bridge for the first time, the list of servers is empty. You must locate the 
servers on the network and add them.

TO START FIERY BRIDGE

• Choose Start > All Programs  >  Fiery  > Fiery Bridge or double-click the Fiery Bridge shortcut on 
your desktop.

TO ADD A SERVER TO FIERY BRIDGE

1 Click Add Server. 

2 If the GA-1310 that you want to add appears in the list of available printers, select the 
GA-1310 and click OK.

If the GA-1310 that you want does not appear in the list of available printers, select “Enter 
printer name or IP address”, type the DNS name or IP address of the GA-1310, and click OK.

The GA-1310 is located on the network and added to the list of servers.

TO DELETE A SERVER FROM FIERY BRIDGE

1 Select the GA-1310 from the list.

2 Click Delete. 

3 Click OK to confirm the deletion.

Configuring server settings

You can configure settings for any of the servers in the list. Currently, the only setting is the 
file format (PDF or TIFF) for a scanned document. Scanned documents do not reside on the 
GA-1310 in PDF or TIFF format. However, when you transfer a scanned document from a 
GA-1310 to your computer using Fiery Bridge, the document is converted to either PDF or 
TIFF format, depending on the setting you configure.

TO CONFIGURE THE FILE FORMAT SETTING FOR THE GA-1310

1 Select the GA-1310 from the list.

2 Click Settings.

3 Choose PDF or TIFF from the File Format list.

4 Click OK.
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Using Fiery Bridge
When you install Fiery Bridge, a Fiery icon is added to the My Computer window on your 
desktop. When you add a GA-1310 to Fiery Bridge, a folder for that server is added under the 
Fiery icon. The folder for the server in turn contains a My Documents folder that contains the 
documents in your mailbox on the GA-1310.

The scanned documents appear as regular files of either PDF or TIFF format (depending on 
the file format setting). However, these files are not actually on your computer. By default, a 
scanned document is not transferred to your computer until you access it by opening it in an 
application on your computer or by copying it to your computer. 

You cannot save a scanned document back to the GA-1310 mailbox. You must save it as a new 
document on your computer. The scanned document on the GA-1310 remains unchanged.

You can access scanned documents by browsing from the desktop, from within an application, 
or from the Fiery Bridge main window.

TO ACCESS A SCANNED DOCUMENT FROM YOUR DESKTOP OR AN APPLICATION

1 From your desktop, open My Computer. 

From an application, choose File  >  Open and browse to My Computer.

2 Under My Computer, open the Fiery icon.

3 Under the Fiery icon, open the folder that has the same name as the Fiery containing the 
scanned document.

4 If you are prompted for a user name and password, type them and click Login.

Select “Save User Information” before clicking Login if you want Fiery Bridge to enter your 
user name and password automatically in the future, even if you reboot your computer. 

5 Under the folder that has the same name as the GA-1310 containing the scanned document, 
open My Documents.

The list of scanned documents appears.

6 If you are browsing from your desktop, double-click a document to open it in its default 
application, or select a document and copy it to another folder. 

If you are browsing from an application, select the document and click Open.

A document is not transferred to your computer until you open it or copy it.
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TO ACCESS A SCANNED DOCUMENT FROM THE FIERY BRIDGE MAIN WINDOW

1 In the Fiery Bridge main window, double-click the GA-1310 that you want to access.

2 If you are prompted for a user name and password, type them and click Login.

Select “Save User Information” before clicking Login if you want Fiery Bridge to enter your 
user name and password automatically in the future, even if you reboot your computer. 

The My Documents folder for the GA-1310 that contains the scanned documents is opened 
in Windows Explorer.

Mailbox synchronization

If you want scanned documents transferred to your computer as they are available (to 
accommodate a particular workflow, for example), you can set up mailbox synchronization. 
With mailbox synchronization, scanned documents are transferred to your computer to a 
specific folder (different from the My Documents folder for the server) as they are created.  
If a scanned document is deleted from your GA-1310 mailbox, the file is deleted from the 
folder on your computer, as well.

TO CONFIGURE MAILBOX SYNCHRONIZATION FOR A FIERY

1 Select the GA-1310 from the list.

2 Select Mailbox Synchronization from the Tools menu.

The Mailbox Synchronization dialog box appears.

3 Type the user name and password for the GA-1310.

4 Click Test Connection to test your connection to the GA-1310.

Fiery Bridge attempts to connect to the GA-1310 using the information you provided and 
shows whether it was successful.

5 If PaperPort is installed on your computer, you can select Add to PaperPort. 

Select this option to add a shortcut to your GA-1310 mailbox in PaperPort.

6 Click OK.

NOTE: The path name of the folder that scanned documents are transferred to is shown in the 
Mailbox Synchronization dialog box. You cannot change this folder location.
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Accessing a different mailbox

After you log on to a GA-1310, you remain logged on until you log out of your Windows 
session. To access a different mailbox on the same GA-1310, you must log on as a different 
user.

TO ACCESS A DIFFERENT MAILBOX ON A SERVER YOU HAVE ALREADY LOGGED INTO

1 On your desktop, open My Computer.

2 Under My Computer, open the Fiery icon.

3 Under the Fiery icon, right-click the folder that has the same name as the GA-1310 that you 
want to access and click Login As.

4 Type your user name and password and click Login.

Accessing WebTools

You can access WebTools for any GA-1310 you have added to Fiery Bridge.

TO ACCESS WEBTOOLS FROM FIERY BRIDGE

1 In the Fiery Bridge main window, select the GA-1310 from the list.

2 Click WebTools. 

The default browser is started and directed to the selected GA-1310.
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HOT FOLDERS

Hot Folders is a utility (available as an option) that allows you to store and reuse frequently 
used print options when printing PostScript and PDF files on the GA-1310. With Hot 
Folders, you can do the following:

• Create special folders (hot folders) that assign specific print settings and print queues 
to jobs

• Print jobs to the GA-1310 by dragging and dropping them onto hot folders on your 
computer’s desktop

• Monitor the status of jobs sent to hot folders

Installing Hot Folders
The installer for Hot Folders is located on the User Software DVD.

Before installing the utility, make sure that you complete the preliminary procedures 
described on page 10.

To install Hot Folders on a Windows computer, see “Installing user software on a Windows 
computer” on page 11. To install Hot Folders on a Mac OS computer, see “Installing user 
software on a Mac OS computer” on page 13.

Using Hot Folders
Complete instructions on how to use the standard Hot Folders features are provided in Hot 
Folders Help.

TO ACCESS HOT FOLDERS HELP

1 Start Hot Folders.

2 Choose Help  >  EFI Hot Folders Help.
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Additional features
The following section describes additional features of Hot Folders that are not discussed in 
Hot Folders Help.

Preserve Document Setting

When you define Job Settings for a new Hot Folder and open the Job Properties window, the 
default for many settings is displayed as Preserve Document Setting. This setting allows you 
to keep the job properties you set when creating the original job in the application.

About Hot Folders filters

Hot Folders filters allow you to convert certain file formats to PostScript or PDF or to 
preflight files for conformity. File conversion and preflighting take place on your computer 
within Hot Folders, which saves GA-1310 resources. You can print files directly from Hot 
Folders filters without starting the application from which they were created.

Using the PDF to PS filter

The PDF to PS filter is standard. The PDF to PS filter accepts PDF (v1.2 through v1.7) files 
and outputs PostScript files. 

NOTE: The filter converts any PDF v1.2 files to PDF v1.7 files, and then to PostScript Level 3 
files before submitting to the GA-1310.

NOTE: This filter is not supported on Mac OS X.

Microsoft Office filters for Hot Folders

The Microsoft Office filters for Hot Folders feature allows you to convert certain MS Office 
file formats to PostScript. File conversion takes place on your computer within Hot Folders, 
which saves GA-1310 resources. You can print files directly from Hot Folders filters without 
starting the application from which they were created.

The Microsoft Office filters have no configurable options; however, you must have the 
following versions of each application, and have a PostScript printer or Acrobat Distiller 
installed to convert the files to PostScript files.

• Microsoft Excel 2000 and higher

• Microsoft Publisher 2002 and higher

• Microsoft PowerPoint 2000 and higher

• Microsoft Word 2000 and higher
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Specifying filter settings for a Hot Folder

After specifying the filter settings and options for your Hot Folder, drag and drop the proper 
file formats onto your Hot Folder to begin the conversion process.

Open the Filter Settings dialog box from the Folder Properties dialog box.

NOTE: These filters are not supported on Mac OS X. The illustration in the procedure below 
shows Windows XP.

TO SELECT A FILTER SETTING

1 From the Hot Folders Control Panel, select the Hot Folder and click Properties.

2 Select Filter Settings and click Define.

The Filter Settings dialog box appears, allowing you to select the filter. 

For Windows, filters are color-coded. Exclusive filters are blue and Non-exclusive filters are 
black. 

If you select an Exclusive filter, you cannot select any other filter. Microsoft Office filters are 
non-exclusive filters, so you can select as many of them as you wish.

3 To convert all PostScript files to PDF automatically, select Convert PS to PDF and a job option 
from the Distiller Profile menu in the PS->PDF Normalizer pane.

4 Click OK.
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WEBTOOLS

WebTools allow you to manage your GA-1310 remotely from the Internet or your company’s 
intranet. The GA-1310 has its own home page, where you can select the following WebTools:

• Home provides current information about the jobs processing and printing on the 
GA-1310.

• Downloads allows remote users to download installers (for drivers, PPDs, and other 
software) directly from the GA-1310.

• Docs allows remote users to access jobs on the GA-1310 over the Internet or intranet. 

• Configure allows the GA-1310 administrator to view and modify Setup options remotely 
from a Windows computer.

NOTE: WebTools allows only Base64 Encoded X.509 certificates to upload to the GA-1310 
via TCP/IP.

Setting up WebTools
WebTools are resident on the GA-1310 hard disk and do not require special installation. 
However, WebTools do require initial setup by the GA-1310 administrator.

To enable network users to access and use WebTools, the administrator must set specific 
options in Network Setup and Printer Setup. For information about these specific Setup 
options, see Configuration and Setup.

The administrator also must prepare each user’s computer to communicate with the GA-1310 
over the Internet or intranet.
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TO SET UP CLIENT COMPUTERS TO USE WEBTOOLS

1 Enable TCP/IP networking.

2 Make sure that the computer has a valid, unique IP address.

3 Make sure that a supported Internet browser is installed on the computer.

For more information about supported browsers, see Welcome.

4 Make sure that Java is enabled in your Internet browser.

In addition, make sure that you have completed the preliminary procedures described in 
“Preparing for installation on Windows computers” on page 10.

NOTE: If the client computer is running Windows XP with Service Pack 2 (SP2) or 3 (SP3) 
installed, or Windows Vista, Pop-up Blocker is turned on by default. With this function 
turned on, a warning message appears when you access WebTools, and your access to 
WebTools is denied. To gain access, do one of the following:

• Change the Pop-up Blocker setting by clicking the warning message and choosing from 
one of the selections that appears.

• Turn off Pop-up Blocker in Internet Explorer from the Tools menu or in Internet Options.

For more information, see Internet Explorer Help, or the documentation that accompanies 
Windows.

Accessing the WebTools home page
Use your Internet browser to access WebTools. For complete information about browser and 
system requirements, see Welcome.

TO ACCESS THE WEBTOOLS HOME PAGE

1 Start your Internet browser. 

2 Type the IP address or DNS name of the GA-1310.

The GA-1310 home page appears. 

If the home page for the copier appears instead of the WebTools page, click the WebTools 
link.

3 Click the tab for the WebTool that you want to use.
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Using WebTools
The following sections describe how to use the WebTools.

Home

Home lets you view jobs that are currently processing and printing on the GA-1310. Printing 
and processing information is updated every 30 seconds.

For complete instructions on how to use Home, see WebTools Home Help. 

Downloads

The Downloads WebTool allows you to download installers (for drivers, PPDs, and other 
GA-1310 software) directly from the GA-1310.

For complete instructions on how to use Downloads, see WebTools Downloads Help. 

Docs

Docs allows you to access jobs on the GA-1310 over the Internet or intranet. You can: 

• Manage and distribute jobs in your mailbox. 

Mailboxes are set up in the Users and Groups area of the Configure WebTool.

• Control and modify jobs.

• Submit jobs to the Print Server.

For complete instructions on how to use Docs, see WebTools Docs Help. 

Configure

Configure allows the GA-1310 administrator to view and modify Setup options remotely 
from a Windows computer. For information about using Configure, see Configuration and 
Setup. 

Before using Configure, make sure you have completed the Configure preparation procedure 
described in “Preparing for installation on Windows computers” on page 10.

For complete instructions on how to use Configure, see WebTools Configure Help. 





INDEX 67

A
Align Trays 20

C
chapter definition for jobs 23, 39
Configure 65
configuring

Command WorkStation, Macintosh 
Edition 35

Command WorkStation, Windows 
Edition 16

connection on Windows 46
server 65
WebTools 63, 64

conventions 8
cover media 24, 40
CT/LW to PS Filter

about 61
configuring 61

D
DCS 2.0 to PS Filter

about 61
configuring 61

DNS name 16, 35
Docs webtool 65
Domain Name Server, see DNS name
dongle 30
downloading software 65
Downloads WebTool 65
drag-and-drop printing 60

F
Fiery utilities, configuring the connection on 
Windows 46
File Filters

selecting settings 62
specifying 62

H
Home WebTool 65

I
icons in documentation 8
imposing jobs 30
imposition layouts 30
Insert Tabs 27, 41
inserting tabs 27, 41
installing

Impose 30

J
Java 15, 64
Java JRE 10
jobs

chapter definitions 23, 39
cover media 24, 40
mixed media definitions 22
VDP 30

M
media definitions 22
Mixed Media 22

P
paper definitions 22
printing frequently used print options 60

R
remote setup 65

S
scanning

from the copier glass 48
server setup 65
software protection key 30
Sun Java JRE 10

INDEX



INDEX 68

T
tab

insertion 27, 41
media 27, 41

TCP/IP 16, 35
terminology 8
tray alignment 20
troubleshooting

Command WorkStation, Macintosh 
Edition 43

Command WorkStation, Windows 
Edition 29

U
user authentication 20, 38
users and groups 20, 38

V
variable data printing, see VDP jobs
VDP jobs

imposing 30

W
WebTools

Configure 65
Docs 65
Downloads 65
Home 65
home page 12, 13, 64


	Terminology and conventions
	Introduction
	About this document
	About Help

	Preparing for installation on Windows computers
	Installing user software
	Installing user software on a Windows computer
	Installing user software on a Mac OS computer


	Command WorkStation, Windows Edition
	Installing Command WorkStation, Windows Edition
	Configuring the connection to the GA-1310
	Using Command WorkStation, Windows Edition
	Additional features
	User Authentication
	Align Trays
	Mixed Media
	Insert Tabs

	Troubleshooting
	Command WorkStation cannot connect to the GA-1310
	Command WorkStation does not respond


	Impose
	Installing and enabling Impose
	Installing Impose
	Installing Adobe Acrobat and Enfocus PitStop

	Using Impose

	Command WorkStation, Macintosh Edition
	Installing Command WorkStation, Macintosh Edition
	Configuring the connection to the GA-1310
	Using Command WorkStation, Macintosh Edition
	Additional features
	User Authentication
	Mixed Media
	Insert Tabs

	Troubleshooting
	Command WorkStation cannot connect to the GA-1310
	Command WorkStation does not respond


	Scan
	Installing and configuring Remote Scan
	Installing Remote Scan
	Configuring Remote Scan

	Using Remote Scan
	Using Remote Scan Help
	Scanning with Remote Scan TWAIN plug-in module

	Scanning from the copier
	Scan destinations from the copier
	Setting up a Mailbox
	Retrieving scans from a mailbox
	Scanning from the copier
	Setting scan options specific to the copier
	Setting scan options from Remote Scan
	Retrieving scans using Docs


	Fiery Bridge
	Installing Fiery Bridge
	Configuring Fiery Bridge
	Specifying servers
	Configuring server settings

	Using Fiery Bridge
	Mailbox synchronization
	Accessing a different mailbox
	Accessing WebTools


	Hot Folders
	Installing Hot Folders
	Using Hot Folders
	Additional features
	Preserve Document Setting
	About Hot Folders filters
	Using the PDF to PS filter
	Microsoft Office filters for Hot Folders
	Specifying filter settings for a Hot Folder


	WebTools
	Setting up WebTools
	Accessing the WebTools home page
	Using WebTools
	Home
	Downloads
	Docs
	Configure


	Index

